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Research Problem

Students today do not have many options for college or career
preparation in the artistic or creative fields. There are many
options when it comes to creative careers that students and parents
do not know about. There were 266,300 graphic designers recorded
in the US in 2019. Based on the additional graphic designers
entering the field and those retiring, in the next 10 years, it is
expected that the US will need 16,700 new graphic designers to
fill those positions. (See Graphic Designer Overview) This project
focuses on teaching the next generation skills in graphic design to
apply to college and their future careers. This will be a stepping
stone to get them where they want to go. It will also show the
students; they can choose what they love as a career.

“

You have brains in your head, you have
feet in your shoes, you can steer yourself
any direction you choose.

– Dr. Seuss
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”

Research statement

This project will be centered around teaching students from 6th
grade to 8th-grade graphic design skills that will build on college and
career preparation. It is a learning interface to teach students basic
graphic design skills that they can build on and use in the future.

“

When you know better, you do better.

– Maya Angelou

”

The interface will be teaching skills that are not normally taught at
these grade levels and making them aware of the options they have
within this field.
Many schools do not have options for students interested in creative
or artistic fields when it comes to learning skills they will need for
their future. Many schools put their budgets and focus on science,
math, and English programs versus the visual arts programs.
The schools usually offer basic electives for art classes at different
levels and graphic design classes on rare occasions. These graphic
design classes are available for high schoolers and are not easily
accessed by the students.
Online resources available for graphic design typically target older
adults rather than middle-school students. These resources can be
overwhelming for younger students to learn with. They can also be
quite boring and time-consuming, making it harder to motivate them
to continue learning. There are not any all-inclusive and trustworthy
graphic design interfaces made for middle-schoolers or young adults.
There may be competitors for this program, such as the American
Graphics Institute (AGI) or Tech-Trep. The AGI offers week-long
programs to teach graphic design to high school students (middle
school programs were not found). This program is expensive, and
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the students will have to apply and be accepted. It also makes them
take a week out of school to attend this course, making it difficult for
some people to access.
The Tech-Trep program offers a similar platform as the NexGen
program, but it focuses on STEM. It offers basic design and
animation programs but focuses on the tech aspects, not the design
concepts. This site does not work well, and it not user-friendly.
These things are key when gaining trust from the consumer. Having
a consumer’s trust allows them to feel confident in purchasing
something from the site. NexGen’s program will be affordable, easy
to access, not time-consuming, have the information needed all in
one place, and be something the student will enjoy.
The graphic design interface will be designed to help students
gain access to creative success. It is a platform to teach the next
generation the fundamentals of graphic design. It will shape their
understanding of the Adobe programs and
graphic design concepts. Then apply the skills
they learned to projects that will help work
towards a better future in this ever-growing
world of graphic design and technology.
This graphic design program will be
based primarily on a website platform.
Through this one platform, the student
and parents will have access to information,
tutorials, projects, and much more.
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Stakeholders

The main stakeholders in this project are the 6th-8th grade students
and parents. This interface is designed for the students. Every
decision made to form and create NexGen revolves around them.
The parents are also important in the decision-making process.
Not many parents know graphic design is an option for their child’s
future, let alone find information about it, or teach them about
graphic design. They make many decisions for their children and
agree to let the students participate in this interface. They must first
agree to trust this interface and then see their child’s progress in the
program. The parent’s participation is crucial in the implementation
and success of their child.
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Research Methods

1. Preliminary research needs to be conducted to obtain

background information into the research questions and the topic at
hand. In this case, the research would be conducted to determine the
benefits of college or career preparation, students learning digitally,
the benefits of learning graphic design, and the basic need to be
taught for graphic design.

2. Visual research is a study of images, forms, and objects in both

visual and material culture. Finding the right visuals is a big part of
this project. The program will be adapted toward middle school and
high school students. I would need to know what visuals are trending
and what visuals resonate with them the most? Once these questions
are answered, the information can be applied to the different themes
of the program. These images will be added to the projects they do
and the instructions they will follow.
I want images that they recognize and think are
“cool.” I am looking for generic shapes or figures,
such as a cartoon avocado. I will use images that
do not have trademarks and that licenses I
will need to acquire. Finding these images
will help the students engaged if they
recognize the imagery or think it is “cool.”
After this research is obtained and the
more popular images are identified, this
information will lead to further discussion
and more research such as interviews or
surveys to confirm the recent findings.
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Proposed Research Methods
If time and resources were available, the following
research methods could be conducted.

1. Surveys will be conducted to find out

more about the target market, which will be
students. Asking questions about topics like
what imagery they like the most? Once the
imagery has been narrowed from the visual
research previously done, the questions that are
asked to the students can be more specific. Other
questions can be asked, such as what may motivate
the students? Would they like to see their artwork on
materials like stickers so they can hold it in their hands? Maybe even
turned into animated Gifs, they can keep on their phone to show
friends? What would be best to get them to continue to learn?
Questions can also be asked about how they like to learn. Do they
like printed information or digital information? Do videos help, or
do step-by-step directions work better? Does feedback help them or
not? It will help answer more specific parts of the knowledge gap.
These questions can help confirm or disprove the preliminary
research. It will also get a better idea of what the students want and
how the program’s curriculum can be best formed to fit them.

2. Interviews could also be conducted with teachers and

professors. I can ask a few people that I know in the educational
interface and see if they have time to answer a few questions. I will
type up specific questions I would like to know, and that will benefit
this program. The teachers of middle and high school students
would be beneficial to better understand how students learn and
motivate them. They teach students every day, so they will have
a good idea of making this teaching experience effective. Also,
professors of colleges to see what students should know before
entering the graphic design program.
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I could also interview professors in the graphic design field and ask
what they expect from students when they first enter their programs.
Communicate with some arts admission committees and see what
they look for when students apply to the arts program. This could
help me figure out what I need to add to the curriculum.

3. After a short rough draft of the program is created, an experiment
can be conducted. Different age groups go through a project as if they
were a hypothetical student signed up for the program.

These experiments would be guided and monitored to record how
they understand the program and find out what they cannot follow.
If the information given is too confusing or at a higher level than
they understand, the information can be taken, and the program
can be adjusted to breakdown the program a bit more. It could
work the opposite way as well, where it might be too simple or
worked through too quickly. That information can be taken, and
the program can be adjusted to make it a bit more challenging.
These experiments will ideally work through the interface bugs,
such as effective motivation, what elements might need to be
added, and what may be too complex for this age group. All
feedback will be applied to the final product to ensure this is the
best experience for the students.
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Preliminary Research Review
Background information has been gathered, such as materials
that help justify the basis for this project. Articles were found on
how college preparation at an early stage is beneficial, how a wellrounded portfolio can help get into colleges or get a good career, and
that there are many jobs for a graphic designer today.
There is also information on how middle school and high school
students learn and, more specifically, how they learn digital tools
and resources. Included in the research is information on graphic
design basics such as the concepts and the software to help build a
good curriculum.
Studies show that college preparation programs can benefit students
starting in middle school and can cause higher graduation rates.
Another source discusses the importance of a well-formed digital
portfolio for higher education and career development. It discusses
what people are looking for in a portfolio, their expectations, and
what can be done to improve their skills. This information can help
form a curriculum around college or career preparation and form a
good portfolio.
Many examples of careers in the field of graphic
design were found. These sources included
interviews with graphic designers from
various professions throughout the graphic
design community. These interviews
discuss the importance of graphics
tools for people other than graphic
design professionals. This shows the
variety that the field of graphic design
and these skills have to offer.
Information was gathered on how middle
schoolers learn, how best to teach them,
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and the effectiveness of teaching middle school students digitally.
It goes through the reasoning of using a computer program to teach
at this level and why it is effective. Explaining that it is important to
use imaginative and stimulating imagery to keep younger students
engaged. Students who learn using graphics and computer programs
gained a higher level of thinking and understanding of the subject.
This solidifies the idea of including design and technology effectively
within a curriculum.
Some materials explain how students respond to constructive
criticism. It established a good way to present feedback to the
students to respond positively and revise their work. This builds
communication, collaboration, critical thinking, and creativity.
This research also covered the basic concepts of graphic design to
better understand how it is thought effectively. This part will be
researched more thoroughly in the next stages of this project. This will
help break down this information to build an effective curriculum.

Research Implications

More research also needed to be conducted on what parts of the
software need to be focused on and how the students would apply it.
This is valuable to know to take this information to help them apply
it to their future careers.
This knowledge will be gathered through visual research, surveys,
interviews, and experiments. By doing all these research methods, I
will have enough information to start planning this graphic design
program’s curriculum. After planning the curriculum, I will start
creating and compiling all the files from this interface.

14 | NexGen Create | Mary Kate Morgan

Knowledge gap

The questions that still needed to be answered after the preliminary
research:
• What are some motivations of middle school students?
• What visuals would they most like to see or create digitally?
• What visuals are trending?
• At what rate does this age group accelerate in learning
• At what rate should students move through this interface?
• What information can I use to persuade students and parents to
use this program?
Before an in-depth interface could be created, an understanding of
middle school interests needs to be established. Through answering
those questions, it helps the middle schoolers that choose to do
NexGen. Everything in the interface will be focused on them and how
they can succeed. More information was needed to create a better
and more entertaining experience for them. The curriculum was
based on the information found from further research and creating
something where the students can benefit.
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Further Research Outcomes
I wanted to focus on the psychology behind these motivational
factors, which led me to several educational journals. The
research includes the importance of professional graphic
designers, the importance of college preparation at a young age,
what motivates students to learn, the effects of reward connected
to success, art classes in schools, and how well students learn
through technology.

“

To increase student productivity, we
must first increase our students’ desire
to learn.

”

– Evan Pitman

An enhanced attitude of excitement within the classroom would
increase the success rates of completed assignments. Derbyshire’s
research focused on “creating ways to make the classroom more
exciting, in turn increasing the motivation of students to complete
assignments.” This idea supports my idea of making the program
happy, creative, and joyful through the imagery I choose. This
information directs the mood in which I want to create this program.
The next article that I found was about motivation. Consistent
with the person-environment fit theory, learners demonstrated
superior progress and achievement when a reward is presented,
and values were well aligned (Using Learner). Another article
experimented with punishment and reward; it concluded that
students’ performance showed an increase in the rewarded trial
(Watabe). With this information, I would like to include rewards
for my curriculum. The students could get stickers printed of their
work or something tangible they can show off to their friends.
This part is one of the many ideas that make this program unique.
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The last article I read on the topic of learning was from Education
Week. This was about a study conducted to see how digital
platforms, like computer-aided teaching, affect students’ learning.
The study showed that the students retained more overall. It
especially helped the students that were already struggling. Their
findings said that the students were able to learn more because they
could make progress at their own pace. This helps support my choice
of platform for the program. It also helps determine the program
should allow the students to work at their own pace. (Cavanagh)
The next part of the research I focused on was the specific careers
in graphic design and their importance within the workplace. The
Bureau of Labor Statistics reports a 4 percent overall increase
in graphic design jobs in the next ten years. While this is slower
than the national average of 7 percent, some areas are growing
much faster. For example, Utah is projected to have a 32 percent
increase in graphic design jobs. Washington State is projected to
have a 23 percent increase, and Tennessee is anticipated to have a
16 percent increase (What Is the Projected). See Graph 1.
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Graph 1
Percentage job increases 2018-2019
Jobs in the US

Graphic Design Jobs in the US

Graphic Design Jobs in Utah

Graphic Design Jobs in Washington

Graphic Design Jobs in Tennessee

Graphic Design has many different paths within this one
field. In this field, they can create books, magazines, catalogs,
newspapers, letterhead, business cards, brand guides, logos,
flyers, brochures, postcards, one-sheets, posters, packaging and
labels, presentations, apparel designs, reports, websites, digital,
ads, illustrations, clip-art, and more.
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The top 8 positions for graphic designers are multimedia designer,
web designer, logo designer, brand identity designer, flash
designer, creative or art director, photo editing or photoshop artist,
and layout artist. Each position opens up new opportunities in
so many different places. The designers work for large and small
companies, agencies, and ever for themselves. Below, Graph 2
shows a visual representation of the top graphic design positions.

Graph 2

1

2

3

4
5

6
7

8

Web Designer
Layout Artist
Logo Designer
Flash Designer
Multimedia Designer
Brand identity designer
Creative or Art director
Photo editing or Photoshop designer
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Graph 3 shows how competitive the field is and the percentages of
graphic designers who choose to leave the profession early. If the
kids are exposed and trained earlier, this could weed out people
who are not as passionate about this field. If a child were to do the
interface early and figured out, they did not like graphic design.
This could be a chance for them to view a few more options before
deciding on a specific subject they want to study in college. This
could potentially help before spending hundreds of thousands of
dollars on college in a field they decide is not for them.

Graph 3
Career length Expectancy of Graphic Designers

40%

30%

Leave Graphic Design within the
first 2 years
Leave Graphic Design before 5 years
in the profession
Remain in Graphic Design past 5 years

30%
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Nationally, 24% of Graphic Designers are self-employed (Best
Cities). I read a few things that suggested high schoolers
interested in graphic design as a career are also advised to take
some entry-level business classes. This will help build the college
preparation side of this program. This adds to the information
students need to know before entering college and.
Finances Online contained a compilation of statistics about how
graphic design helps with consumer appeal, brand recognition, etc.
Graph 4 shows the importance of graphic design in the workplace
and what important people thought of the profession. (Chang)

Graph 4
How do Smbs rate the importance of
Graphic Design to their success
0%

10%

20%

30%

Very Important

50%
49%

Moderately
Important

31%

10%

Very Important
Slightly
Important
Not Important

40%

7%

3%
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All this information can help me persuade my customers that
this program is important because Graphic design is important.
It is a career that you can benefit from, and there are many
opportunities out there. It is a growing field because of all the
media out there today, the media that needs to be designed.
The last part of my research is the school interfaces and their
affiliation with the visual arts programs. A National Center for
Education Statistics Report on Arts Education states that 89%
of the public elementary schools surveyed provide visual arts
subjects at the school. 40% of the same schools say they offered
five or more different courses in the subject (Parsad). These
statistics are to show how large the arts program is in elementary
schools. Graph 5 below visually shows these statistics.
Showing the vast interest in art students have at a young age. I

Graph 5

Elementary Schools surveyed

Public elementary
schools surveyed
provide visual arts
subjects at the school
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Of the same schools
say they offered five
or more different
courses in the subject

researched some local high schools’ curricula to see their graphic
design programs and offer them. I found many that did not and
a few that did. The ones that did offer them are minimal, and
some are difficult to access. I have two examples of schools that
do offer them in the state of Virginia. Fairfax County middle
schools’ elective lists include a class called “Computers in Art”
(MS Standard). Amherst County offered a graphic design class
as half a credit. Amherst County High School Program of Studies
of 2018-2019 described this class as a practical, hands-on guide
to help students understand digital art (Amherst County). This
course includes a lot of basic graphic design principles.
It looks like a very reasonable entry-level course. It hits many
good points that a student will need to know in graphic design,
but I feel like it still needs to offer more. There are no higher
levels and for it to be only one semester. That does not seem long
enough to understand all the ideas they list in the class. It would
also not be enough to make a well-rounded digital portfolio for
applying to colleges.
I have not found much on the images I might be using and what
images would best resonate with them. I was trying to look for
trends in middle schoolers and high schoolers and what imagery
they are drawn to. I have not found any academic sources on this
topic. My next step is with finding imagery through non-academic
sources like Twitter or Instagram and doing surveys of students. I
have not done surveys or started writing questions yet. I still need
to get IRB approval, and it is important to go through this for the
universities and my liability.
I would also like to conduct surveys and interviews with teachers
and professors. I can ask the teachers of middle and high school
students. It would be beneficial to understand how students learn
and what helps motivate them. I can ask the professors to get a
feel for what they want the students to know before entering their
classes. I want to send this out to many different schools to see if I
can get feedback. Example survay questions are on page 24.
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Questions will be answered on a scale from 1 to 10
(1 being the lowest and 10 being the highest) and openended questions.

1. How much experience do you usually see students having when
entering a basic level graphic design class?
1 2 3 4 5 6 7 8 9 10

2. If the students have experience, what kind of programs do they have

experience using?

3. If they have experience, were they taught in school or self-taught?
4. How much experience do you think they should have before taking a
basic level graphic design course?
1 2 3 4 5 6 7 8 9 10

5. What programs should they know before taking a basic level graphic

design course?

6. What tools should they have experience using within these programs
(ie. pen tool, selection tool, direct selection tool)?

7. What basic design concepts should they understand before taking a

basic level graphic design course?

8. What do you think should be in a student’s portfolio when applying
to a college graphic design program?

9. How much of the portfolio should be digital art?
1 2 3 4 5 6 7 8 9 10

24 | NexGen Create | Mary Kate Morgan

Research Conclusion

My research so far answers a few of my questions. Such as what
motivates the students, what makes learning exciting, and that
giving rewards for achievements is helpful. This information will
help me create an overall mood for the interface and build a unique
atmosphere where a student can learn effectively. Also, I gathered
information that will help persuade the student and parent to use the
program. Information that will be used within the website to explain
the benefits of the program.
Once I continue with the rest of my research methods, such as the
surveys. I will be able to answer some of my questions more indepth. What visuals will be best for the students, and what kind of
experience is needed for college. Once these questions are answered,
I will start building on the curriculum and projects that have been
established. All this information will help me provide a program that
is the most beneficial for the student and helps them succeed.

“

”

Success is the sum of small efforts,
repeated day in and day out.

– Robert Collier
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Project Overview
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Project Statement
NexGen will focus specifically on college or career preparation
and education programs in graphic design for the next generation;
students in grades 6th-8th. It will be used to spark an interest
in graphic design and create a path to plan for their future. The
target audience will not only be the students but the parents as
well. The parents are the ones investing in their children’s future.
The NexGen interface will be located on one website. The part of
the website that can be accessed without logging in is focused on
selling NexGen subscriptions. It will have information on what
the interface is, how to use it, what themes are available, the
subscription costs, and more.
There will be a monthly subscription for NexGen. It will include
all the functions that this interface has to offer. The plan is that
this subscription cost will be small enough that lower-income
families will still have access. This could be done through
sponsorships and outside funding. Once the parents purchase a
subscription, it will instruct the students and parents to create a
login to access their profile.
Once the student has logged in, they will assess how much they
know about arts, design concepts, and the software. Once they
have finished the assessment, we will know what level the student
should start. This assessment will make sure that it is best suited
for the student, so they are getting the most out of this program.
An example of the assessment can be found on pages 54-60.
Throughout this interface, they will be learning Adobe Illustrator,
Adobe Photoshop, and Adobe InDesign. The plan for this
interface is to partner with Adobe. This partnership will give
the student the ability to download the Adobe and NexGen
plugin. Access to this plugin will be included in the subscription.
Similar to Adobe Creative Cloud, The Adobe+Nexgen plugin
will be updated automatically when an update is needed. The
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Adobe+NexGen plugin is a simplified version
of the Adobe programs. This plugin will help
keep the student focused on the task in front
of them and not be overwhelmed with all
Adobe’s functions. The plugin will start
with a limited number of tools available.
As the student progresses through
the level, they will unlock tools. More
information on the Adobe+NexGen
plugin can be found on page 78.
This program could potentially be expanded
to include Adobe After Effects and Adobe
Premiere Pro. With these skills, students will
be able to edit videos themselves. This is very popular with
YouTubers and students wanting to upload their videos. However,
for now, this program specifically will focus on the three main
graphic design programs.
The students will have a choice of three themes. They will keep
this theme throughout their learning process, following the same
characters and storyline with the theme they chose. This is to
ensure they are engaged with the interface and continuing to
excel. Themes and characters can be found on pages 63-64. An
example of a storyline can be found on pages 65-67.
A big part of this interface the curriculum that the student will
follow. The interface will be starting with learning the concepts
of graphic design and the basic tools used within the Adobe
programs. These concepts will be applied through projects and
assignments. They will be able to download the projects and
open them to the Adobe+NexGen plugin. They can then follow
the instructions in the project and edit the file. The projects will
become more challenging and more in-depth as they work their
way up. A brief outline of the curriculum can be found on pages
61-62. An example of a project can be found on pages 79-80.
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“

If things start happening. Don’t worry.
Don’t stew. Just go right along and start
happening too.

– Dr. Seuss

”

When the student creates an account, the parent will also make
an account. The parents will be able to view their child’s progress
throughout the learning interface. They can also manage their
payment plan and payment methods. Support and resources will be
available to them; one of these resources will be the parent’s guide.
A parent’s guide will be included for the parents to access. Each
page will include a summary of the tools function, a small tip to
keep the student motivated, and some resources that they can visit
if they get stuck on an assignment. The resources include videos
and articles that are not on the NexGen website. The plan is that
the articles and videos are will be associated with NexGen either
through a partnership or a sponsorship. These are given to the
parents first so they can screen the resources if they would like.
This guide is not to give the parent information to teach the child.
It is to make the parent understand what the child is working
on or having trouble with and giving them resources to alleviate
the situation. If this does not help the situation,
they have the tutoring resources available as
well. Adobe can be a complex program; these
recourses like tutoring and the parent’s guide
are put into place to ensure the student
learns the most through this interface.
More Information on the partent’s
guide can be found on pages 81-90.
Through preliminary research, it has
been proven that students react positively
and lean more through feedback and
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instruction. Another aspect that will be included is feedback.
As the student finishes a project, they will submit the finished
product for feedback. With the evaluation, we will be avoiding
negative or rough critiques. Instead, the students will be given
positive feedback with some suggestions on making their work
even better. For example, the feedback could be, “You did a
great job; just make sure to check all of your points are lined up
correctly.” This will help them understand their mistakes but not
get discouraged by harsh critiques.
The plan is that the feedback will come from a well-calibrated
computer interface alongside a team of trained graphic designers.
The computer will quickly run through the project, ensuring that
it meets the basic criteria for the assignment. If something is
flagged, a team member will then look over it to see how it can be
abjected and respond to the student.
If the assignment is returned to the student too often, the student
will be contacted by one of the tutors. The tutors are there to
make sure the student understands the assignment and there
to answer any questions the student may have. These tutors are
included in the NexGen subscription.
Also included in the subscription is tech support for downloading
the program plugin, issues they may have with the program, and
more tech-related questions the student or parent may have.
There is also a contact option for new users to talk to someone
about getting a NexGen subscription.
There will be 5 projects on each level of the interface. Before
the student can move on to the next level, all projects must be
assessed and marked as completed. The feedback will be given
to the students within 48 hours of being submitted. The Graph
above shows the visual time of the submission process. Once the
project is approved and new levels are opened, the student will
be rewarded.
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Feed Back Timeline
Submit Project

In Review

Feedback Received

The rewards include points that will go towards the on-site shop
and opening more tools in the plugin. The points system and
unlocking tools or levels are also known as gamification. Games
and game-like elements have been used to Educate, Entertain,
and Engage for thousands of years. Some classic game elements
are points, badges, and leader-boards (Fitz-Walter). Once they
have completed projects and levels, they earn points. These points
can go toward receiving free or discounted items from our online
shop. These items could include stickers, notebooks, posters,
bags, and more that would have their designs printed on them.
They will have something that they can be proud to show to their
friends and family.
Chat rooms and communicating when going through a game
is popular with students. This could also be an option for the
student to do through a student chat function. This could help
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them stay motivated. If their friend is on level 5 and they have
been not, they will want to keep going and catch up. They can
also chat to ask questions if they are stumped. This will teach
communication and collaboration, which they are going to need in
their careers.

By the end of the interface, the student will have many projects
completed, including original designs that they put into a
portfolio. From start to finish, this program will give them skills
to succeed all in one place. An interface for children that includes
skills and information they will need for their future.
This will be promoted through Digital Advertising. The campings
will run on social media platforms like Instagram and Facebook.
These advertisements will target the Parents and the Students.
They will draw their attention and pique their interest, so they
will want to know more. The advertisements will link to the
website so they can get started.
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Project
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Brand

Overview

When designing the NexGen brand, the colors, logo, and font
needed to be considered. This brand is teaching the next generation
of designers. The visuals should be modern, almost new age. It
needs to depict a futuristic element to show moving forward toward
the future. At the same time, it needs to be appealing to middleschool students.
The colors were the first to decide on; they set the mood for the rest
of the project. According to Kendra Cherry from Very Well Mind,
yellow is attention-grabbing, energetic, and warm. Since yellow is the
most visible color and reflects the most light next to white, it is also
the most eye-catching color. Yellow can be used in a small amount to
draw attention, such as on traffic signs. Yellow is also often used in
situations and products intended to create a sense of excitement or
energy. This brand needed a color that would attract the parents and
students and make them excited about NexGen. (Cherry, The Impact
of the Color Yellow)
The next color was the darker blue-green that is featured in the
logo with the yellow. Blue is often used to decorate offices because
research has shown that people are more productive in blue rooms.
Blue gives the feeling of calmness or serenity. This is a good color
to use in something academic it can calm the student and aid in
productivity. The different blue shades help differentiate shapes
within designs and make sure there is not too much of the same blue.
(Cherry, The Impact of the Color Yellow)
Blue and yellow were the only colors used because too many colors
can get too busy, and it is hard to assign hierarchy. In the brand
guidelines, yellow is not used in large amounts but stands out
amongst the different blue shades. Even though it is used less than
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blue, it is still the main color because it is seen first and is the most
memorable. So, anything in yellow is the main focus and more
important in most cases. Each color used in the brand is listed with
their CMYK color, RGB color, and Hex color to be reproduced and
used on other pieces in the future.
The second piece of the brand was the logo. This distinguishes
NexGen from its competition and other companies. The logo must
be eye-catching and meaningful. Quite often, it is the first thing that
a potential customer will notice about your business. The logo is a
point of recognition for new and returning clients. (The Importance
of Logo Design)
In the beginning stages of this project, the logo started a little
different. It had a thing modern font and a thin script. The design
was not interesting or eye-catching. It would not stand out amongst
a crowd. With much consideration and advice, it evolved. Now it
has a noticeable image accompanying a bolder font. The shape of
the logo was designed to resemble the selection tool in all the Adobe
programs. Since NexGen was teaching how to use the programs,
it fitted to use a recognizable symbol to represent the brand. The
overlapping of the colors created depth and interest. The logo can be
used vertically and horizontally. Examples of the logo inverted and in
use are displayed below.
The third piece is the font used on pieces created by the brand as
the website, parent’s guide, and digital ads. The fonts chosen are
Bungee and Georgia. Bungie is bold and modern, which are great
characteristics to represent what NexGen stands for. It is great for
headers and sub-headers. The second font is Georgia, which is a
classic. It fits nicely with Bungee and looks professional. It is great
for large body text and can be easily read in large amounts.
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Primary Logo:

Inverse Logo:

Main Font Used For Headers: Bungee

Color Scheme:

Secondary Font Used For Sub-Headers and Body Copy: Georgia

C: 20
M: 19
Y: 50
K: 0

C: 0
M: 40
Y: 92
K: 0

C: 48
M: 9
Y: 18
K: 0

C: 70
M: 22
Y: 24
K: 0

C: 79
M: 49
Y: 46
K: 20

R: 207
G: 194
B: 142

R: 250
G: 166
B: 49

R: 131
G: 192
B: 203

R: 73
G: 159
B: 181

R: 60
G: 100
B: 109

Hex: CFC28E

Hex: FAA62F

Hex: 83C0CB

Hex: 499FB5

Hex: 3C646D

abcdefghijklemnop
qrstuvwxyz.!?&@
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklemnopqrstuvwxyz
.!?&@
WEbsite Splash Page:
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Common Motif:

Website
Overview

The website will consist of information about the company and the
learning interface. It is one of the most important parts of getting
parents and students on board. 38% of people will stop engaging
with a website if the content or layout is unattractive (27 EyeOpening Website Statistics). The website’s public side will be a
platform to captivate the parent’s and students’ interests.
It is important that is deliverable looks captivating and explains
significance of this interface. It will be professional while, at the
same time, still being playful. A few pages will explain exactly what
this program is, what it will
be teaching, and how to get
access to the program.
The design of the
website matches
the brand and
is visually
captivating.
There are
more
images
on this
site than
there is copy.
Users spend an
average of 5.59
seconds, looking
at a website’s
written content (27
Eye-Opening Website
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Statistics). Integrating a large number of images is good when
delivering important information.
The second function of this website is the private login for students
with paid subscriptions. It will be the platform used to find all the
information about the program, where the students can access the
program, and where the parents can monitor their child’s progress.
The private side of the website will be the program. This private
side will reflect the theme the student chose when they signed up
for the program. This theme will include the main character that
the student will follow as they progress through the interface’s
levels. Once inside a level, the website will have interactive stories,
interactive quizzes, and illustrator files to download.
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Menu Tree
HOME
ABOUT
· NEXGEN
· GET STARTED
· LEARNING
· BENEFITS

Spop Themes
· ASTRONAUT ADVENTURES
· SUPERHERO SCUFFLE
· MONSTER MANIA

SUPPORT
· NEW STUDENT, TECH, AND TUTORING

LOGIN
Profile
· ACCESS TO PROGRAM

Shop rewards
· ACCESS TO SHOP WHERE STUDENT CAN
PERCHANCE ITEMS WITH THEIR DESIGNS

Student chat
· ACCESS TO COMMUNICATE WITH STUDENTS
WORKING ON THE SAME PROJECTS AS THEM
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Home Page Sketch
Logo, Menu, and Login.

Slide show with
captivating pictures and
catchphrases linking to
other pages on the site.

This will the about
briefly discussing who
NexGen is and what
they do.
The process of how to
get started or sign up
for the program.
Video explaining the
process of how to get
started.

Brief descriptions of
the themes and links to
learn more.

This will explain what
the student will be
learning if they do the
program linking to
more info.

The benefits of taking
the program will be
explained using stats.
FAQ section answering
questions students and
parents might have.

Contacts to support for
new students, tech, and
tutoring.
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About Page Sketch

Logo, Menu, and Login.

Header picture.
This will the about
briefly discussing who
NexGen is and what
they do.
The process of how to
get started or sign up
for the program.
Video explaining the
process of how to get
started.

This will explain what
the student will be
learning if they do the
program linking to
more info.

The benefits of taking
the program will be
explained using stats.
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Shop Themes Pages Sketch
Logo, Menu, and Login.

Brief descriptions of
the themes and links to
learn more.

Logo, Menu, and Login.
Header picture.

Brief descriptions of the
Theme.
Some key points that
would be covered in this
story.

Images that are used in
the story to give them a
glimpse of what if would
look like.

Footer with logos and
link people might need.
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Support Page Sketch

Logo, Menu, and Login.

Header picture.
Contacts to support for
new students, tech, and
tutoring.

FAQ section answering
questions students and
parents might have.

Footer with logos and
link people might need.
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Profile Page Sketch
Logo, Menu, and Login.

This will list out the
levels the student
can complete and the
sections in each level

The themes main
character saying
welcome.

Link to the teaching
portion of that section.

Footer with logos and
link people might need.
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Learning Pages Sketch
Logo, Menu, and Login.

Instructions on how
to use tools and what
functions Adobe
Illustrator has.

The themes main
character acting out
seres in the story.
Buttons to the next page
to learn more about this
section.

Logo, Menu, and Login.
How many pages they
have left in the section.

This will explain what
the student will be
learning if they do the
program linking to
more info.
The benefits of taking
the program will be
explained using stats.

The themes main
character acting out
seres in the story.
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Once they reach the end
of the section they will
download an AI file to
work from.

shop Page Sketch

Logo, Menu, and Login.

Search field and filters.

Cart button that links to
the cart to check out.

Character to make the
page more exciting.

All of the products
available to buy.
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student chat Page Sketch

Logo, Menu, and Login.

List of previous and
current chats.

Conversation between
students.

Typing field and send
button.
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Student Workflow Outline
The parents and students will first purchase a NexGen Subscription.
The subscription process will make them create a username and
password to get into their account.
When the student first signs into their account, they will have to
complete an assessment. This will determine what level the student
needs to start their lessons. Assuming they are beginners and do not
do very well on the assessment, they will start at level 1.
When the student has been talking their lessons for a while, they will
feel comfortable with the website. They will have a few options to
choose from when they first log in. They can start their lesson, shop
their rewards, go to the student chat, or contact support.
If they start their lesson for the day, they will go to their profile
and find their uncompleted section at their current level, then
click “start adventure.” They will either read through the story and
explaining how to do the task at hand or watch a video reiterating the
information above. They have two options to choose from depending
on how they like to learn. Some students learn better by reading and
others by watching. Once they have read or watched how to do the
task, they will move to the next page.
The next page will have the story, explanation, and video just
on another task. Once they have read or watched both task
explanations, they will be able to download the project file and
open it in the Adobe+NexGen plugin. The plugin should already be
installed on their computer. Once the file is open, they will begin the
task that correlates with the storyline. When they have completed
the project, they will save the file and resubmit it on the same page
they downloaded it. They could move on to the next section or wait
for feedback to the next level if it was the last section in the level.
After the project is reviewed, they will earn points.
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If they want to shop rewards with their points, they need to click
the “Shop Rewards” menu item. Once they are on the page, they
can scroll through the items or search for a specific item they want.
They click the item they want, and it goes into the information about
that item. It will then compare the price to their points; if they have
enough to get the item entirely, the price will be $0. If they do not
have the entire amount, the price will be shown as discounted. If
they pick, the item they will then click on “Customize Now.” They
will take them to a gallery of the work the student has submitted.
They will select the image they want to be printed on the item and
click “check out.” They will then complete the process of checking
out and purchasing the item.
If they choose to chat with other students, they can select the
“Student Chat” menu item. They will enter a chat platform similar
to Facebook Messenger. They will connect with other students
by replying to chats previously made charts, start new chats, and
making new friends.
The last thing they can do is go to the “Support” menu item. If they
are having an issue, they can contact one of our team members to
help. If they are a new NexGen member, they need tech support
or need tutoring. They can call or start a live chat to get their
questions resolved.
View a Visual Representation on Page 50.
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Sign up for
NexGen

Create an
Account and
Sign In

Student
Chat

Lessons

Start
Lesson

Create
Chat

Watch

Read

Both

Chat

Search

Support

Scroll

Select
Item

New
Student

Tutor

Tech

Chat

Call

View
Price

Page 2

Read

Shop

Watch

Download
Project

Both

Customize

Purchase

Complete

Submit
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Parents Workflow Outline
The parents and students will first purchase a NexGen Subscription.
The subscription process will make them both create a username and
password to get into their account. The parents will have access to
student progress, support, parent resources, and payment.
If the parent were accessing their child’s progress, they would go
to the page named “Student Progress.” They will be able to view
the points earned, what level and section they were working on,
what work was pending feedback, and the work that has been
completed. They can view the submitted work as well to see how
their child is progressing.
Parents are also able to view their payment account. They
can view their past statements and the subscription they have
purchased. It will show how much and when it will be taking out
in the upcoming month. They will also be able to update their
information and payment method.
They also have the ability to view resources to help their child work
through this program. They will not be teaching them directly, but
the resources will help motivate them and better understand what
the student is working on.
The last thing they can do is go to the “Support” menu item. If they
are having an issue, they can contact one of our team members to
help. If they are a new NexGen member, they need tech support or
need tutoring. They can call or start a live chat to get their questions.
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Sign In
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Assessment Example
Start Assessment

1

You create a file with text and images and decide that you
want to put the text on it’s own layer, without changing
it’s position on the artboard. What steps can you take to
move your text to a new layer?

Choose one
F Select the text with the Selection tool and then choose Locate
Object from the Layers panel menu.
F Select the text with the Selection tool and then choose Collect
in New Layer from the Layers panel menu.
F Select the text with the Text tool and then choose Release to
Layers (Sequence) from the Layers panel menu.
F Select the text with the Text tool and then choose Release to
Layers (Build) from the Layers panel menu.

Back
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Next

2

You have selected an object that contains a Drop Shadow
effect that you want to modify. What steps should you take?

Choose one
F Click on Drop Shadow effect in the Appearance panel and then
modify the effect.
F Choose Effect > Stylize > Drop Shadow, apply and modify the
new effect.
F Choose Effect > Document Raster Effect Settings and modify
the effect
F Choose Object > Expand Appearance and modify the effect.

Back

3

Next

You have scanned a sketch and want to draw on top of it.
What steps should you take?

Choose one
F Choose the Draw Inside option after placing the scanned
sketch.
F Choose the Draw Behind option after placing the scanned
sketch.
F Use the Perspective Grid tool after placing the scanned sketch.
F Choose the Template option when placing the scanned sketch.

Back

Next
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4

You are exporting an icon to be used on a web page, but a large
area, the size of your artboard, is saved with the file. What
steps can you take to save only the size needed for the icon?

Choose one
F Choose Object > Artboards > Fit to Artwork Bounds.
F Select the icon and choose Object > Artboards > Convert to
Artboards
F Select the artboard with the Artboard tool and then turn off the
Move/Copy Artwork with Artboard.
F Select the artboard with the Artboard tool and then turn on the
Move/Copy Artwork with Artboard.

Back
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Next

5

You have created a new document with 3 artboards and want to
change the names and dimensions. What steps should you take?

Choose one
F Select each artboard with the Selection tool and specify the
names and dimensions in the Control panel.
F Select each artboard with the Selection tool and specify the
names and dimensions in the Appearance panel.
F Select each artboard with the Artboard tool and specify the
names and dimensions in the Control panel.
F Select each artboard with the Artboard tool and specify the
names and dimensions in the Appearance panel.

Back

Next
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6

What is the best description for the button circled in the graphic
below?

Choose one
F Press the circled button in order to convert a solid stroke into a
dashed stroke.
F Press the circled button in order to even distribute dashes and
corners in an already dashed stroke.
F Press the circled button in order to step up the size of the
dashes in the selected stroke. Press the button to the left to
reduce the size of the dash.

`

F The selected button is a toggle button. If your selected stroke is
solid, pressing the button will make it dashed. If your selected
stroke is dashed, pressing this button will make it solid.

Back

7

Next

You are using the Selection tool to resize the dimensions of a text
box, but the text is reflowing rather than resizing. What can you do
to make the text resize rather than reflow to the dimensions of the
bounding box?

Choose one
F Choose Type > Convert to Area Type.
F Choose Type > Convert to Point Type.
F Choose Type > Create Outlines.
F Choose Type > Optical Margin Alignment.

Back
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Next

8

You are creating a Custom Workspace and want to dock one panel
to another panel. How do you dock (rather than free float) panels so
they don’t cover other panels?

Choose one
F Drag the panel and touch the tip of the mouse pointer to a side
(or top/bottom) of another panel and let go when a blue bar
appears.
F Drag the panel and touch the side (or top/bottom) of the panel
to a side (or top/bottom) of another panel and let go when a
blue bar appears.
F Activate the User Interface preference to Auto-collapse iconic
panels.

Back

9

Next

You have selected 3 objects and want to align them to the top of a
specific object. How can you specify the Key Object?

Choose one
F Shift-click the specific Key Object and then click the Vertical
Align Top button in the Align panel.
F Single-click the specific Key Object and then click the Vertical
Align Top button in the Align panel.
F Double-click the specific Key Object and then click the Vertical
Align Top button in the Align panel.
F Single-click the specific Key Object and then choose the Object
> Compound Path > Make.

Back

Next
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10

What are characteristics of a Global Color Swatch?
(Select two)

Choose all that apply
F Global Swatches have a white triangle in the bottom right
corner.
F Global Swatches don’t have a white triangle in the bottom right
corner.
F Changing the color of a Global Swatch changes the color all
objects that share the same swatch.
F Changing the color of a Global Swatch changes the color of only
the currently selected object.

Back

11

Next

You created a logo and want to ensure that the typeface does
not change it’s appearance when used on other computers.
What can you do to ensure that your typeface does not
change?

Choose one

F Use a TrueType font.
F Use an OpenType font.
F Select the text with the Selection tool and then choose Type >
Create Outlines.
F Select the text with the Text tool and then choose Type > Re
solve Missing Fonts.

Back

(American Graphics Institute)
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Finish

Curriculum
Beginner Introduction
• How to name and organize layers
• How to save files to be submitted
• How to use guides
• How to Use Artboards
• Brief design overview
• Design is in the details
• Keep sketching
• Encouragement

Illustrator

Level 1 — Basic Tools

• Section 1 — Selection Tool
• Section 2 —
 Line Tool
• Section 3 — Shape Tools
• Rectangle Tool
• Ellipse Tool
• Polygon Tool
• Star Tool
• Section 4 — Color Tools
• Design Concept Lesson (Uses of RGB vs. CMYK)
• Color Panel
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• Swatch Panel
• Eyedropper Tool
Level 2 — Type Tools

• Section 1 – Type
• Design Concept Lesson (Basic Typography)
• Character Panel
• Paragraph Panel
• Type Tool
• Section 2 – Area Type Tool
• Section 3 – Type on Path Tool
• Type on Path Tool
• Wrap Path
• Section 4 – Vertical Type
• Vertical Type Tool
• Vertical Type Area Tool
Level 2 — Pen tool and direct selection tool
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Characters
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Themes

Astronaut Adventures

Superhero scuffle

Monster Mania
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Story Example
This story is about
Jerry, the astronaut.
Jerry never took
anything seriously
in his life. Classic
rock songs, from The
Byrds to Stix, were the
soundtracks to his life.
One day he said, “What
the heck, I am going to become
an astronaut.” So he signed up,
went through the training, and
got sent on a mission to Mars.
Even he was surprised, he passed
his training and was sent on this
mission. However, he has to
follow his orders.
The day had arrived. He glided
down the walkway to the
shuttle, was strapped into his shuttle, and the countdown began,
3.. 2... Jerry pulls out his phone and pressed play. His phone is
connected to the stereo system he had installed just for this mission.
The words reverberating through the capsule were, well, nothing
except drums and guitar because there is a minute and thirty-second
intro to “The Final Countdown” by Europe. However, once the verse
starts, “The final countdown” plays loud enough for the aliens to hear
(we will get to them later).
He breaks through the atmosphere, and pieces of the shuttle break
off, and he sees the world get smaller behind him. He hits next
on his phone because he has the perfect song qued up for this
occasion. “She packed her bags last night pre-flight,” is now playing
throughout the cabin. All the time, Jerry is singing along. He has
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songs like this to make it to Mars. All
he has to do is sit back, relax, and rock on.
Smooth sailing from here, right? Wrong.
Remember, when I said, “even the aliens
could hear the music?” Well, they were
so intrigued by this strange sound they
had to go and find it. The alien clan that
heard this music sent one of their best
trackers, Bquao (no one knows how to
pronounce that). He sets off with his
trusty space monkey that he rescued
a few years back. He found him just
floating in space. His name is Albert.
They set off searching for this noise
that they cannot tell if they like or are
annoyed with it.
While Jerry was rocking out and staring
into space, he sees another spaceship
coming straight for him. He pulls out his
phone and scrambles to find the perfect song for what is happening.
He knows just the right one. He presses play on “Come Sail Away,”
by Styx.
As that plays in the background, he sees the ship getting closer.
They are right above him now. He starts to feel weird, and his
hands started to look glitchy and start to disappear. He closed his
eyes tight. As this was happening, the song came to its final verse,
“I thought that they were angels. But to my surprise. We climbed
aboard their starship. We headed for the skies.” (perfect timing,
right?) Once he opened his eyes again, he was standing in a huge
space ship that looks decades ahead of where the earth was.
He then saw a strange looking creature carrying a monkey on his
shoulder. Jerry thought to himself, “that monkey looks familiar. Oh,
well.” He shrugged it off.
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Baquao looked at Jerry and said, “I am Bquao, and this is Albert.
Were you the one making that noise?” Yes, aliens can speak English.
Where did they learn it? No idea.
Jerry was confused. He did not know what noise this strange
creature was talking about. His music
was not noise. Jerry thought for a
second and pulled out his phone. He
askes, “Is this what you are talking
about?” He pressed play. From his
ship, you can hear clearly from the
other ship, “I woke up
this morning
with light
in my eyes,
and then
realized
it was
still dark
outside.”
Bquao says over
the music, “That is
it!! What is that?”
Jerry starts to explain, “It is a
song. This is ‘Hey Mr. Spaceman’ by The Byrds.
I thought it fit the situation nicely. I have so many more where
that came from.” Bquao, now listening closely to the music, hears,
“Hey, Mr. Spaceman. Won’t you please take me along? I will not
do anything wrong. Hey, Mr. Spaceman. Won’t you please take me
along for a ride?”
He says, “He says no!” Then he Directs his lasers at Jerry’s ship and
hits the big red button. Jerry’s ship blows into pieces. Baquao dops
Jerry on the moon and flies away. Now it is your turn to help Jerry
find all of the pieces and put the ship back together. (This is where
the projects start.)
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Home Page Final
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The website will consist of information about the program and the
program itself. The website’s public side will be teaching parents and
students about the program and how it is beneficial to them.
This side of the website will be oriented towards marketing to the
parents and students. It will be professional while, at the same time,
still playful. A few pages will explain exactly what this program is,
what it will be teaching, and how to get access to the program.
The Home Page Includes information about the program, how to get
started, the available themes, some statistics about the benefits of
teaching graphic design, and some assistant resources.
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Login Page Final

Once the student creates an account, they will be able to log in and
access their profile whenever they want. The third profile will include
their progress through the interface.
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Profile Page Final
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Level 1 section 3 Page 1 Final
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This is the teaching portion of the interface. When the student
works their way through the levels, they will encounter pages
similar to this. They will start with a piece of a story that coincides
with the next task. Next will be instructions on how to complete the
task. Below is a video tutorial talking them through the functions
of the tools being used. There is also a page number that coincides
with the parent’s guide to keeping up with the student’s progress. It
will also show what Adobe+NexGen Program they are going to use
with this task. It will also have the next button to go to the next task
in this section.
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Level 1 section 3 Page 2 Final
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This is the second task in a section. It will have all the same features
as the first but it will not have a next button. It will have a “download
project” button. This will download the project that the student can
open in the Adobe+NexGen plugin. Once the student has completed,
they can submit it back to the website for review and move on to the
next task in that level.
Their location and content do not coincide with the curriculum
because these tool were the easies to show examples for and easier to
understand. They are together because this made them easily found.
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Plug in mock up
+

Open

Save

Undo

Redo

Help

Layers

Help!!!

Jerry’s rocket is broken and the pieces are floating
away. He needs your help to collect all the pieces
and to put his rocket back together.
Grab the pieces with your select tool and place
them in their outlines areas.
Reminder!

Select tool looks like this:

it is at the top of your tool bar
to the left of your workspace.

+

Reach FOr
the Stars

The Adobe+NexGen plugin is a simplified version of the adobe
programs. This plugin will help to keep the student-focused in the
task in front of them and not overwhelmed with all the functions that
Adobe has to offer. As you can see it has few functions and it only
used for teaching the basic functions of the more important tools in
the Adobe programs. The plugin will start with a limited number of
tools available. As the student progresses through the levels, they
will unlock tools. The tools that are unlocked will coincide with
where they are at in the curriculum. The yellow and white tools are
available to use and the white ones hare not unlocked yet.
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Example of project page 1

Help!!!

Jerry’s rocket is broken and the pieces are floating
away. He needs your help to collect all the pieces
and to put his rocket back together.
Grab the pieces with your select tool and place
them in their outlines areas.
Reminder!

Select tool looks like this:

it is at the top of your tool bar
to the left of your workspace.
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Example of project page 2

HIde!!!

Jerry’s rocket is fixed but the alien knows what
the rocket looks like. You have to disguise the
rocket by painting it a different colors.
Select a white square below and then select the
dropper tool. Using the dropper tool choose a
color that you want from the planets in space.
Repeat this for all 4 squares. Once you have the
colors you want to use on the rocket select the
parts of the rocket and repeat the same process
that you used to change the color of the squares.
Reminder!

Dropper tool looks like this:
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it is at the middle of your tool
bar to the left of your workspace.

Parents Guide
OverView

Encouraging parent engagement is one of the best ways to create
a positive learning environment for every student. Studies show
that students with parents involved with their education and
schoolwork have high test scores, better attendance, self-esteem, and
higher graduation rates. Across fifty different studies, educational
researchers found a connection between family involvement and
academic achievement. The earlier educators establish parent
engagement, the more effective they are in raising student
performance. (How Parent Involvement)
This can also benefit the parent. One of the main benefits of assisting
your students with assignments is learning more about what they
are studying. Doing homework
assignments with children
motivates parents to take
a more active part in
school or college life. It
encourages them to
communicate more
with their child and
teachers
Communicating
is the best way
to improve
the quality
of education.
(HomeWorkHelper.
net.)
This is what NexGen
would like to promote. By
having resources available to
81 | NexGen Create | Mary Kate Morgan

the parent, it encourages them to be involved. The parent’s guide will
help the parent understand what the student is working on and ways
the parent can guide the student along while working through the
interface. It will help when the student gets stuck or confused. There
will be page numbers on the student’s version of the interface that
corresponds with the parent’s guide. The parent can look at what the
student is working on, find the page number, and find ways to help.
This guide is designed for an adult. It still reflects what the student
sees on the website, such as some of the characters. It is also is clean,
with more professional language. It appeals to the adult, but in a
way, they can still relate to what the student is seeing.
A downloadable PDF Parent’s Guide will be developed to aid parents
in guiding their students through the NextGen projects. This
printable PDF will be accessible through the NextGen website. This
can also be placed in a printed booklet format that can be ordered
through the website.
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Preliminary Sketch
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Parents Guide
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Introduction
1 Layers should be Organized

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis
nostrud. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.

2 Save Files Correctly

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis
nostrud. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.

3 Make sure the student Has fun

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis
nostrud. Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.
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1

Selection tool
Lorem ipsum dolor sit amet, consectetur adipiscing
elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Fly trhough this in no time

Make sure you and your child stay positive. When a task
gets challenging make sure to look back at the instructions
a few times. Tell them to work though it slowly making sure
they did not skip a step. Keep the encouragement going and
they can get through anything .

Resources
VIDEOS
• Link 1
• Link 2
• Link 3
• Link 4
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ARTICLES
• Link 1
• Link 2
• Link 3
• Link 4

2

Line Tool
Lorem ipsum dolor sit amet, consectetur adipiscing
elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed do
eiusmod tempor incididunt ut labore et dolore
magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed do
eiusmod tempor incididunt ut labore et dolore
magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed do
eiusmod tempor incididunt ut labore et dolore
magna aliqua.

Always be positive

Make sure you and your child stay positive. When a task gets
challenging make sure to look back at the instructions a few
times. Tell them to work though it slowly making sure they did
not skip a step. Keep the encouragement going and they can get
through anything they want.

Resources

VIDEOS
• Link 1
• Link 2
• Link 3
• Link 4

ARTICLES
• Link 1
• Link 2
• Link 3
• Link 4
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3

Rectangle Tool
Lorem ipsum dolor sit amet, consectetur adipiscing
elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

They are doing a great job

Make sure you and your child stay positive. When a task
gets challenging make sure to look back at the instructions
a few times. Tell them to work though it slowly making sure
they did not skip a step. Keep the encouragement going and
they can get through anything .

Resources
VIDEOS
• Link 1
• Link 2
• Link 3
• Link 4
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ARTICLES
• Link 1
• Link 2
• Link 3
• Link 4

EyeDropper tool

4

Lorem ipsum dolor sit amet, consectetur adipiscing
elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed do
eiusmod tempor incididunt ut labore et dolore
magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed do
eiusmod tempor incididunt ut labore et dolore
magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed do
eiusmod tempor incididunt ut labore et dolore
magna aliqua.

All this new info can be scary
Make sure you and your child stay positive. When a task gets
challenging make sure to look back at the instructions a few
times. Tell them to work though it slowly making sure they did
not skip a step. Keep the encouragement going and they can get
through anything they want.

Resources

VIDEOS
• Link 1
• Link 2
• Link 3
• Link 4

ARTICLES
• Link 1
• Link 2
• Link 3
• Link 4
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5

Type Tool
Lorem ipsum dolor sit amet, consectetur adipiscing
elit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua. Ut enim ad minim veniam,
quis nostrud.

Lorem ipsum|

Lorem ipsum

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Lorem ipsum dolor
sit amet, consectetur
adipiscing elit, sed
do eiusmod tempor
incididunt ut labore et
dolore magna aliqua.

Make Sure to keep them motivated
Make sure you and your child stay positive. When a task
gets challenging make sure to look back at the instructions
a few times. Tell them to work though it slowly making sure
they did not skip a step. Keep the encouragement going and
they can get through anything .

Resources
VIDEOS
• Link 1
• Link 2
• Link 3
• Link 4

90 | NexGen Create | Mary Kate Morgan

ARTICLES
• Link 1
• Link 2
• Link 3
• Link 4

Digital Advertising
OverView

This is the time to market almost solely through digital platforms.
97% of digital consumers have used social media in a month. 52%
of all online brand discovery still happens in public social feeds.
Consumers are 71 percent more likely to purchase a product based
on social media referrals. 31 percent of online consumers say
they searched on social media for products before purchasing. 80
percent of consumers engage with brands through social media.
59 percent of global consumers use social media as a source of
inspiration for purchases. Social media is great as a marketing tool
to gain recognition and let our target market about NexGen. (Why
You Need to Invest)
Running a social media ad
campaign is a great way
to reach new users.
With an ad campaign,
you can determine
exactly what type of
user you want to
target and place
your content
directly
in their
newsfeed.
Also, it is
very costeffective to run
a social media
ad campaign.
They give you the
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option to choose a daily budget or a set amount for the ad’s life.
The social media platform will charge you a few cents to a couple
of dollars per click. The user also has the ability to run different
campaigns. Depending on what campaign is doing the best, the
budget will go towards the campaign that is getting the most results.
The advertiser can closely monitor the outcome of each ad and adjust
to get better results. Compared to traditional advertising, the overall
cost, targeting, and outcome are much more manageable. (Why You
Need to Invest)
The digital advertising visuals will be the first thing a parent or
child will learn about NexGen. They must be eye-catching and
interesting. These will be placed on Instagram, Facebook, Twitter,
and Google. These platforms are some of the most used platforms
in today’s market.
The first version of the ad campaign uses a mix of cartoon
characters and real people. The real people in the images are in the
approximate target age group. This is, so they relate to the images.
The parents will relate if they have a child in that age range. The
cartoon characters are in the image to create intrigue and curiosity
to learn more.
The second version of the ad campaign used the same element
differently. In this campaign, it is as if the children are in the cartoon
character’s word instead of the character being in theirs. As if the
student could delve into a different world. Either design could be
effective in different ways.
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Preliminary Sketch
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Ad Campaign version 1
DESIGN THE NEXT CHAPTER

Teach the Next Generation

Useing Imagination to create
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Ad Campaign version 2
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